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Introduction Objectives

This manual is written to give you a step-by-step guide for your
classroom training and a handy reference for your daily work. In
this Introduction, you will learn how to use this training guide
effectively. This section covers the following topics:

* Anintroduction to the Crystal Reports application
* Pre-Qualification Exercise

* Class objectives

* Help with using this training guide

* Information on how to start the program
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Introduction

About Crystal Reports

Training Philosophy

In today's information intensive environment, every business has a database
of some sort. After all, business today is all about information and databases
give you a handle on the massive amounts of information you must deal with.
Therefore, your business has a database and from that database, you need
reports. The problem is, most reporting capabilities that come with database
programs are limited. They only report on data from that program. Many
users need to report on data from multiple sources, even databases that are
in SQL (Structured Query Language), such as Oracle, Microsoft SQL Server,
Informix or Sybase.

Crystal Reports is one of the most powerful reporting programs available with
the ability to pull data from all types of data sources. You can use Crystal
Reports to generate reports from any of the standard PC database programs,
Access, Paradox, or FoxPro, as well as from a mainframe or server
database. Crystal also has a powerful web-reporting server that allows you to
distribute your reports over the web.

Crystal Reports is bundled with more than 160 other programs including
Visual Basic, some medical applications, many accounting packages and
several ERP solutions. It makes report generation easy without requiring you
to be a programmer or a database expert. If you know how to work in a
Windows environment and are familiar with the data you want to use, you can
create a Crystal Report that looks professional and makes sense.

Studies show that people retain 10% of information they see, 20% of
information they hear, 50% of what they see and hear, and 80% of what they
see, hear and do. In line with this, this class utilizes a hands-on method of
training. You will see the effects of new procedures on the screen, hear the
instructor explain how and why to use features, and perform the actions
yourself as you learn.

In addition, this class focuses on your ability to perform tasks using the most
productive techniques. The manual may contain several methods of
accomplishing a certain task. However, class time does not allow for practice
of all methods for each task. Your instructor will guide you in the most
effective method of performing a task, but inform you of other methods that
are available.

Questions are encouraged. While we give our best effort to explain new
concepts in understandable terms, you may need to hear the concept again
or have it explained more thoroughly. Please let the instructor know when
you need more information!
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Pre-Qualification Exercise for the Designer 2 Workshop

Why Should You Pre-qualify Yourself for the Designer 2
Workshop?

The Crystal Reports Designer 2Workshop is designed for the experienced Crystal
Reports user. It covers the more complex and powerful features of the program.
The class discusses very technical issues and includes several fast-paced,
comprehensive exercises. Our instructors have years of experience helping
students to get the most out of their training. However, it is not always possible in a
high level workshop to assist students with basic tasks.

In order to maximize the benefit you receive from the Crystal Reports Designer 2
Workshop, you should come into the training with a certain skill level. We assume
all students who sign up for this workshop have a comfortable level of
understanding regarding relational databases. Students should also be able to
perform the following tasks in Crystal Reports:

Create a new report, insert fields, save the report and refresh the data.
Add multiple tables to the report using the Data Explorer.

Use the select expert to pull only the data needed from the database.
Insert groups and summarize fields within the group.

Perform formatting tasks.

Create, save and use formulas in the report.

If you would like to evaluate for yourself whether this is the correct level course,
take our self-evaluation exercise. The exercise consists of writing a report in
Crystal Reports. When you are finished, compare your report to the one our
experts have done to see how well you understand the basic features of Crystal
Reports. You can obtain the exercise and the results report from the Vision Harvest
web site, www.visionharvest.com, or by e-mailing us at
training@visionharvest.com.

If you have trouble creating the report or getting the correct results, or if you cannot
perform some of the above-mentioned tasks, then we strongly recommend that you
take the Crystal Reports Quick Start Workshop before attending the Designer
2Workshop. By assuring that you are well prepared for the Designer 2 Workshop,
you maximize the benefits you receive from this in-depth look at advanced report
writing.
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Introduction

Pre-qualification Exercise

Using the Xtreme sample database that ships with Crystal Reports, create a report
that invoices customers for each order. The report needs to show the customer
billing address, the PO#, the sales person, the order date, the requested date, the
ship date and company that shipped the order. The Details section should list the
product ID, the product name, the description, the unit price, the quantity, and the
line item total.

Select only those orders with an Order Amount greater than zero and with a ship
date between January 1, 2001 and March 31, 2001. Group on the Customer ID,
then on the Order ID. Display each order on its own page. Sum the line item total
amount for each Order ID. Calculate the sales tax for the order at 6% and total the
subtotal and sales tax.

You will need to pull data from the following tables:

Customer Product
Orders Product Type
Orders Detail Employee

You will need to create the following formulas:

Line Item Total that multiplies the unit price times the quantity for each product
ordered.

Sales Tax that multiplies the sum of each line item total times 6%.

Order Total that adds the sum of each line item total and the sales tax.

Product Description that contains nested if...then....else statements to show the
Size field if the Color field is empty, the Color field if the Size field is empty, and
both fields, separated by a comma, if both contain data.

You will need to create the following text boxes:

An address box with the text To: then the company name, the address, the city,
region postal code and country.

An employee box with the employee first name, a space, then the last name.

Format the report to look like the illustrations on the following pages:



Crystal Reports XI Designer 2 Workshop ©2005 Vision Harvest, Inc.

Introduction

Invoice
Date: December 27, 2002 t 9 g
Invoice Number: 1143 m r m

Mountain Bikes

To: City Cyclists Order.Date: January 6, 2001
. Required D ate: January 9, 2001
7464 South Kingsway . .
. Ship Date: January 8, 2001
Suite 2006 Ship Via: FedEx
Sterling Heights, M1 48358 P ’
USA
Sales person: Nancy Davolio
Product Product Name Description  Unit Price Quantity  Line Total
4102 InFlux Crochet Glove med $12.83 1 $12.83
1107 Active Outdoors Lycra Glove  xsm $16.50 3 $45.50
Subtotal: $62.33
Sales Tax: $4.05

Order Total: $66.38
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Invoice

Date: December 27, 2002
Invoice Number: 1246

Fdtrerne

Mountain Bikes

To: City Cyclists Ord er. D ate: January 30, 2001
. Required D ate: January 30, 2001
7464 South Kingsway . .
. Ship Date: January 30, 2001
Suite 2006 Ship Via: Picku
Sterling Heights, M1 48358 p Via: P
USA
Sales person: Margaret Peacock
Product Product Name Description  Unit Price Quantity  Line Total
1108 Active Outdoors Lycra Glove  sm $14.85 3 F44 55
103151 Endorphin 15 $8959.85 1 $899.85
101152 Descent 15 $2,939.85 1 $2,939.85
Subtotal: $3,884.25
Sales Tax: $252.48
Order Total: $4,136.73
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Introduction

Class Objectives

This class is a performance based instructional system. It is geared to
provide you with the tools you need to build and distribute reports the
quickest, most efficient way. After completing this course, you will be able to
perform the following tasks:

* Refresher Exercise

* Use multiple sections in reports for advanced formatting techniques

* Underlay graphics and charts to print beside data

» Calculate running totals in reports

* Develop parameter fields to prompt users for information

* Limit user entry into parameter fields

* Solve table link problems with advanced linking techniques

* Understand Crystal Reports data handling and Evaluation Time functions

* Comfortably make use of variables in formulas

* Work with arrays and control structures in formulas for more flexible
decision making

* Use additional reports within a main report as subreports

* Create linked subreports to tie data from another report to the current
report

* Format subreports to display on demand only

* Customize groups in the report with formulas and custom names and
create hierarchical groups

* Perform group selection based on summary field values

* Create and format Cross-Tab reports and create charts from Cross-Tabs
*  Working with Report Alerts

* Creating and using Report Templates

* Creating Custom Functions

* Reviewing Advanced Formula Syntax

* Create SQL Commands and SQL Expressions

* Review Advanced Database Concepts
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Introduction
About This Manual
Each section of this manual contains objectives to provide you with the
overall goals for the lesson. Lessons have descriptions of features and
concepts followed by systematic directions for completing a specific task.
Each section ends with a challenge exercise to help you practice the skills
you learned in the lesson. Challenge exercises provide you with tasks to
accomplish. Try to complete these exercises on your own.
As you work in this Training Guide, certain conventions are used to identify
specific procedures. Use the following table as a guide:
TRAINING GUIDE CONVENTIONS
Item lllustrated As
Menu Commands Underlined letters for accessing menu commands are shown:
Example: File/Open
Command Buttons Commands in dialog boxes are shown as buttons:
Example: |ENTER

Categories, Radio All options within dialog boxes are listed in italicized text:

Buttons, Text Boxes,

Check Boxes Example: the Keep Group Together check box

the Other radio button
Keystrokes Keyboard keys are indicated by uppercase text:

Example: press ENTER

Keyboard combinations are shown in uppercase text with a plus sign
(+) between the keys that need to be pressed simultaneously.

Example: press CTRL + S to save
Toolbar Buttons Toolbar buttons are indicated by the button name and a graphic
image of the button:

Example: click the Print %Lutton

Typing or File Selections | Text to be typed or file names to be selected are printed in bold
letters:

Example: type Henry

select grouping.rpt
Exercises Step-by-Step exercises in the text are indicated by bold text and the
s symbol.

For example: < Exercise - Format Objects
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Tips, Notes, and Warnings

Tips, notes and warnings display with the following icons. Text for these
additional comments display in bold and italics.

Q This icon indicates a TIP or shortcut.
This icon points out a NOTE of additional information.

@ This icon calls attention to a WARNING or very important
note.
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Notes Page
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Lesson 1: Refresher Exercise

Lesson 1
Refresher Exercise

15
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Lesson 1: Refresher Exercise

Lesson Objectives

After completing this lesson, you will be able to:

* Plan and Create a report from a set of business requirements
Review the techniques needed to plan and create a report.

* Add multiple groups to reports
Create groups within groups to subdivide your reports how you want.

* Summarize different group levels
You can effectively summarize information at any group level or all
group levels.

* Insert simple lines and boxes for formatting
Make reports professional and attractive with graphical features.

* Utilize the Repeated Group Header feature
Add a "Continued..." message when a group prints across pages

1A
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Lesson 1: Refresher Exercise
Review of Planning a Report

To make the report creation process efficient, you must plan the report. A
little work up front before you ever open Crystal Reports can save you a lot
of time putting the report together. It can also save problems caused by
adding more tables to the report that can change the number of records
displayed.

You must look at the business requirements for the report and decide what
fields you need and the tables in which they are located. It is also helpful to
look at things such as groupings, whether you need Cross-Tabs and what
fields they contain, fields needed for formulas and selection criteria.

Suppose someone asks you to create a report based on the Xtreme
Sample Database 11. Below are the business requirements for the report:

* The person requesting the report needs to see monthly customer sales
by Supplier and Product Type. They want the Order ID, the Product
Name, the line item Unit Price and Quantity and a total for the line
items.

* They want the sales amounts summarized for each supplier, product
type and month.

* They only need to see sales for 2004.

*» Some of the groups are large enough to display on more than one
page. They want the Supplier Name and Product Type repeated at the
top of each page. If the group continues from the previous page, they
want the word "Continued..." to print.

* The person requesting the report has supplied you with a printout of
what the report should look like. See the sample on the next page.

17
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Lesson 1: Refresher Exercise

Monthly Sales by Supplier
and Product Type

Supplier Name: Active Qutdoors
Product Type: Gloves

Order 1D

January 2004

Product Mame

1184
1148
1158
1246
1243
1188
1190
1175
170
1147
1174
113
1233
1207
1221
1126
1146
1143
1238
1203
1132

Active Outdoors Lycra Glove
Active Outdoars Lycra Glave
Active Outdoars Lycra Glave
Active Outdoors Lycra Glove
Active Outdoors CGrachet Glove
Active Dutdoors Crachet Glove
Active Outdoars Lycra Glave
Active Outdoars Lycra Glave
Active Outdoors Lycra Glove
Active Dutdoors Crachet Glove
Active Dutdoors Crachet Glove
Active Dutdoors Crachet Glove
Active Outdoors CGrachet Glove
Active Outdoors CGrachet Glove
Active Outdoors Lycra Glove
Active Outdoors Lycra Glove
Active Outdoars Crochet Glove
Active Outdoars Lycra Glave
Active Outdoors CGrachet Glove
Active Outdoors CGrachet Glove
Active Dutdoors Crachet Glove

Mountain Bikes

Unit Price Quantity Line Total
F16.590 1 §16.40
$16.590 3 $49.50
$16.590 3 $49.50
$14.85 3 44 55
$14.50 1 §14.50
F14.80 2 §28.00
$16.590 3 $49.50
$16.590 2 $33.00
$16.50 1 §16.50
F14.80 3 §43.80
F14.80 2 §28.00
$13.78 2 §27. 86
51378 1 513.78
$14.50 1 §14.50
$16.50 3 §48.50
$16.40 2 §33.00
$13.78 2 $27.96
$16.590 3 $49.50
$14.50 1 §14.50
$14.50 1 §14.50
F14.80 2 §28.00
1648.45

To create this report, first determine which fields you need.

* For the Detail section, you need the Order ID field, Product Name field,
the Unit Price field and the Quantity field.

* For the Line Total formula, you need to multiply the Unit Price field and
the Quantity field.

* For grouping, you need the Supplier Name, the Product Type Name,
and the Order Date.

* Finally, you need to select orders from 2004 based on the Order Date.

Next, decide which tables you need to add to get the required fields.

* The Supplier Name field is in the Suppliers table.

* The Product Name field is in the Products table.

* The Order ID and Order Date fields are in Orders.

* The Unit Price and Quantity fields are in Orders Detail.

* The Product Type Name field is in the Product Type table.

1R
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Since the Supplier Name is the main grouping, the Suppliers table should
be the Primary table. From there you want to link Suppliers to Products with
the Supplier ID field, link Products to Orders Detail with the Product ID field,
link Orders Detail to Orders using the Order ID field, and, finally link
Products to Product Type using the Product Type ID field.

Creating the Report

Since you have given this some thought and figured out the tables and the
links, adding the tables in the correct order and creating the links is easy.
The links should look like the following illustration:

& Database Expert

Data | Links
Link together the tables you added to the report.
Linking is needed to match records of one table with corresponding recaords of another table.
[ Auto-Arange
Auta-Link
I Supplier 1D ~ MiF ~ IC> Crder ID > Order ID ~ i
Supplier Mame Price {SRFP) I Product ID Order Amounk (2) By Name
Addressi [ Product Type ID Unit Price [ Customer 1D 1By ke
Addressz Product Class Guantity I Erployee ID -
City L » Supplier ID - Crder Date w
[ Order Links... ]
B Praduct Type ID [ Clear Links |
Praduct Type Mame
Graphic Image Location
Index Legend...
< >
[ ] ] [ Cancel ] [ Help ]

Remember that you can add multiple tables to a report from the Database
Expert. You work with links using the Links tab on the Database Expert.
The Database Expert is accessed under the Database menu or by
selecting the Database Expert %= button on the Expert Tools toolbar.

determined by the order they are displayed in the Selected Tables
section of the Data tab in the Database Expert. Order and links of the
tables can be manually changed once they are displayed in the Link
tab.

: The order in which the tables are displayed in the Link tab is partly
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Placing Fields on the Report

Remember that you have five ways of placing fields on a report. Select the
field in the Field Explorer, then:

Click the Insert button, then click in the report

Double click the field, then click in the report

Press ENTER, then click in the report

Drag the field to the report

Right mouse click, choose Insert to Report from the short cut menu,
then click in the report

Remember, when you place a field in the Details section, Crystal Reports
adds a detail field title in the Page Header section and aligns the field and
field title with a guideline. You can drag the guideline marker in the ruler to
move the field and its title together.

Now that you have planned the report, you are ready to use Crystal
Reports to create the report.

% Exercise 1.0 - Begin the Monthly Sales by Supplier and
Product Type Report and Link the Tables Needed

1. Starta new report as a blank report. Open the Create a New
Connection folder then the ODBC (RDO) data sources and the
Xtreme Sample Database 11 data source. No password is needed
to access this database. Add the tables indicated by the business
requirements. Right click on the data source and select Add to
Favorites as we shall be using this database throughout the class.

2. The Auto-Link feature should link the tables automatically. Clear
the links and do them yourself.
When you are finished the links should look like the illustration on
the previous page.

3. Add the appropriate fields to the Details section.

4. Change the Printer Setup to a Portrait page layout, if necessary.
Change the margins to be .5” on all four sides.
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Creating the Formulas

You are also going to need two formulas for this report. It can be helpful to
write out the formulas during the planning stage to be sure that you have
accounted for all necessary fields. The formulas you need for this report are
as follows:

@Line Total
{Orders_Detail.Unit Price} * {Orders_Detail.Quantity}

@Continued

If InRepeatedGroupHeader then “ Continued...."

Remember that formulas are created from the Field Explorer dialog box.
Select Formula Fields, and then click the New ‘& button. After naming the
formula, the Formula Editor dialog box opens providing you with three lists
to select fields, functions and operators.

s Exercise 1.1 — Create the Formulas and Add to the Report

1. Select Formula Fields: in the Field Explorer dialog box, then click
the & button.

2. Name the formula Line Total and select the Use Editor button.
3. Create the formula shown above.

4, Add the formula to the report Details section after the Quantity
field.

5. Create the Continued formula, but do not add it to the report yet.

You will add this formula later to display a "Continued" message in
the group header. NOTE: The InRepeatedGroupHeader function is
a function in the Print State category. Click the + sign to the left of
Print State in the middle list in the Formula Editor, and then scroll to
find the function. Double click the function to add it to the formula.
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Advanced Grouping

You can group data by using the Insert/Group... command or by clicking
the Insert Group button {E on the Insert Tools toolbar or the Group Expert
button £ on the Expert Tools toolbar. This report requires an Order Date
group nested inside a Product Name group, nested inside a Supplier Name
group as shown in the Group Expert illustration below.

B Group Expert @

Available Fields; Group By: * -
=2 Report Figlds ~ E supplier.Supplier Name - &
= Orders, Order ID E Product_Tvpe.Product Type Mame
m= Product. Product Mame = Orders.Order Date - &

= Orders_Detail. Unit Price
m= Orders_Detail, Quantity
o= Ovders.Order Date

/= Supplier, Supplier Mame
m= Product_Type.Product Typ
%4 Line Total

+ Crders

1 AR mwdmes Pkl b

< ¥ < >
[Browse Data... ] [ Find Field... ]

[ (] ][ Cancel ][ Help ]

As you create groups, Crystal Reports nests each group inside the previous
one you created. However, you can reorder groups in any order you want.
To reorder groups, click the Group Header section name at the left of the
Design screen, for the group you want to move. The group header and
footer sections are highlighted. Drag the group to the new location. The
mouse pointer changes to a grabbing hand as you drag. In the Group
Expert shown above you simply move the group headers using the arrows
in the top right of the window

FPage Header

| Grouo Header #1:

Details

| Groun Footer #17

Report Footer

22



Crystal Reports XI Designer 2 Workshop ©2005 Vision Harvest, Inc.

Lesson 1: Refresher Exercise

TIP: When you group on a date field, Crystal Reports allows you
to define the period for which the date is broken down; i.e.

Q monthly, yearly, quarterly, etc. A third drop-down list appears
automatically in the Insert Group options dialog box allowing
you to specify when the group is printed.

Change Group Options
Common | Options
“'hen the report iz printed, the records will be zorted and
qrauped by
=l N ders. Order Date M
in azcending order, w
[ ]Use a Formula as Group Sort Order
The zection will be printed:
for each month. w
[ k. ] [ Cancel ] [ Help ]

Remember that you can summarize any field by RIGHT clicking it, then
choosing Insert Summary... You must specify the type of calculation you
want Crystal Reports to perform and the group at which you want the
summary to appear.

% Exercise 1.2 — Create groups and summarize the Line Total
field

1. Open the Group Expert window using the Group Expert £ button.
Create a group on the Product Type Name field. Turn on the
Repeat group header on each new page feature by selecting the
Options button

2. Create a second group on the Supplier Name field. Also, turn on
the Repeat group header on each new page feature.

3. The report requirements call for the report to display information by
Supplier Name and then Product Type. You need to change the
order of the groups. Select the Product Type Name field in the
Group By window of the Group Expert. Select the Down Arrow to
reorder the groups.

The Supplier Name should be the first group in the Group Expert
with the Product Type name nested underneath.
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4. Create a third group on the Order Date. Using the Options button
and choose to print the section for each month.

5. Create a summary for the Line Total column. You will need to do
this three times, once for each group.
All the summary fields should automatically line up on the guideline
to which the field is attached.

Insert Summary _

Chooze the field to summarize:

¥4 Line Total b

Calculate this surmmary:

Sum L7

Surnmary location

Grand Total [Report Foater] w

Grand Taotal [Report Footer)
= Group #71: Supplier. Supplier Mame - &
= Group #2: Product_Type Product Tope Mame - &
E Group #3: Orders.Order Date - &

=g ==

[ k. ” Cancel ” Help

Selecting Certain Records

Remember that Crystal Reports pulls all records from the database unless
you filter the records based on some criteria. The business requirements
for this report requests only records from the year 2004. To specify this,
use the between operator and specify all records with an order date range
beginning 01/01/04 and ending 12/31/04.
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«+ Exercise 1.3 — Select records with an Order Date in 2004

1. Make sure there are no fields selected on the report, and then click
the Select Expert %" button on the Expert Tools toolbar.

2. Choose the Order Date field.
3. Choose the is between operator.
4. In the first drop-down list, select 1/1/2004 0:00.

5. In the second drop-down list notice that 12/31/2004 is not available
for selection. Choose any date and change the entry to read
12/31/2004 0:00

6. At this point save and preview the report. Name the report
Exercise1_0.rpt

Helpful Hints for Formatting the Report

Adding and Working with Text Objects

Once you have created a group, you can delete the group name field from
the group header without affecting the grouping. You can delete the
Supplier Name and Product Type Name fields from Group Headers #1 and
#2, then create a text object in Group Header #2 that contains the Supplier
Name and Product Type.

Remember that text objects can contain text you type and fields from the
report. You can add a field to a text object by dragging the field from the
Field Explorer dialog box into the text object. Once you have a field
selected, the mouse pointer changes to an arrow with a + sign when you
are pointing into a text object. You can also move a field from the report
into a text object. The text object must be in Edit Mode (flashing insertion
bar in the text box and a small ruler in the horizontal ruler at the top of the
report).

AEREERRERE
|
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Also remember that you can format all or part of a text object:

* To format the entire text object select the object (there are handles
around the object) then apply the formatting.

* To format part of a text object, double click the object to enter Edit
Mode, and then select the part you want to format. When the part is
highlighted, apply the formatting.

* To format a field inside a text object, double click the object to enter Edit
Mode, and then click on the field. Once the field is highlighted, apply the
formatting.

Hiding and Suppressing Sections

Remember that you can hide or suppress sections in a report by RIGHT
clicking on the section name in Design view and choosing the appropriate
command. Hiding a section causes the section details to not display in the
Preview tab. However, users can double click summaries to display hidden
details. Suppressing a section causes the section to not display without any
options for viewing it. A hidden or suppressed section will be grayed out in
the Design tab.

Guidelines

As a reminder, you can add horizontal guidelines to the rulers at the left of
each section and snap the tops or bottoms of objects to the guidelines to
horizontally align them.

s Exercise 1.4 - Format the Report

1. Return to the Design view. It is easier to add and format objects
from Design view.

2. Add the title and format as you see it in the sample report on page
on page 18. Add the Xtreme logo to the right side of the Report
Header.

3. Delete the Group #1 Name and Group #2 Name fields from Group
Headers #1 and #2.
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10.

11.

12.

Using the sample report, create a text box in Group Header #2.
Type the text Supplier Name: then add the Group #1 Name:
Supplier Name field from the Group Name fields in the Field
Explorer. On the second line of the text object type the text Product
Type: then add the Group #2 Name: Product Type Name field.
Format all objects in the text box to Bold. You may need to resize
the text box. See the sample on the next page for final formatting.
HINT: Format the text object border rather than drawing a box
around the object. It is easier and you only have one object to deal
with plus if you resize the text object the border will grow with it
whereas a box will not.

Hide Group Header #1. It no longer contains anything you need to
see in the report.

Add a text box to the Group Footer #1 with the text Total for this
supplier:. Move the summary field into the text object. Format the
entire object to be Bold, 14 pt., and right aligned.

Add a text box to the Group Footer #2 with the text Total for this
product type:. Move the summary field into the text object. Format
the entire object to be Bold and right aligned.

Format the summary field in the Group Footer #3 section to have a
top double line border. Make sure the summary field and text boxes
are all snapped to the guideline on their right edges so they line up.

Snap the field titles to a horizontal guideline. Use the guideline to
move the field names from the Page Header section to the Group
Header #3 section under the Group #3 Name field. Format the titles
so they have no underline.

By placing the titles in this section, the titles will reprint with each
month’s data.

Format the Order ID field to display without a comma. Format the
Unit Price field, the Line Total formula, and all the summary fields
to have a floating $.

HINT: Refer to the bullets on page 19 for directions on how to
format the summary fields inside the text boxes.

Depending on how you have the default formats set for Date/Time
fields; you may need to reformat the Group #3 Name fields. The
date should look like this: January 2004.

Add a text box to the left of the Page Footer. Use Special Fields to
indicate Page N of M. Add another text box to the right of the page
footer that reads Order information as of. Add the Data Date
special field after the text. Format both boxes to be italics.

27



Crystal Reports XI Designer 2 Workshop ©2005 Vision Harvest, Inc.

Lesson 1: Refresher Exercise

13. To add the word "Continued..." for a product or supplier group that
is continued on an additional page, place the @Continued formula
field in the text object that contains the Supplier and Product
Names.

14. Save and preview the report. Do not forget that you can navigate

easily through the report using the Group Tree section at the left of
the screen. Just click the group you want to view. Close the report.

The Design view of the report should be similar to the following illustration:

E¥. Crystal Reports - [Exercised_0.rpt]

@ File Edit ‘Wew Insert Format Database  Report  Window  Help
DeEe-Hl &ESE& ® Ca I =D& A E M 100% = | N2 |
Stark F‘age/fE:-cercisel_l].rpt Xl 4 b
Design | Preview 7Y
1 =) ,@ 1 2 1 3 1 Evl ) "O' 5 'U i 1 7T
Feport Header N T S R A
Manthly:Sales by Supplier:. . § - -
- 5andzP:r:cz>duc;tzszpezzzzzzzzzzzzzzzzz5555555E:3ti"em@
R R R EERE SRR Mountain Bike:
Grouo Headsr #1: e e i et 4
G[UU Heade[ﬂz: R P e PR NI
Pmd'f;ct_Type_PmductTyp. Supplier Name: {Group: #1Named: oo o
- | [Product Type: {Group #2 Nam'e} {@Coritiniied) .-~~~ -ooo0oooooon oot
e e o - Browp#d Maine - 1111 II I
- Tlorderit | Progucthame 00T T R PREE D Auan
Detailz
L"lmyp FEUtler ES:_
Group Footer #2;
GCroupl_Fogter IT_‘I: . .
Report Footer
Page Footer
g : >
For Help, press F1 Records: 2617
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Notes Page
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Notes Page
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Lesson 2
Power Formatting with

Multiple Sections
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Lesson Objectives

After completing this lesson, you will be able to:

* Create multiple sections
Expand your formatting power by learning how to add sections to
the report.

* Underlay a section
Display a graphic or chart beside the data it represents by utilizing
the underlay feature.

* Use multiple sections for conditional formatting
Add additional sections that only display under certain conditions.
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Using Multiple Sections in Reports

By default, Crystal Reports gives you five design areas to use when
building your report: Report Header, Page Header, Details, Report Footer,
and Page Footer.

Design

Report Header | - - v

PEQE HEadEf ............................

DEtEIilS ............................

HEpDrt FDDtE[ ............................

Page Fl:ll:ltEr ............................

Each area contains only a single section when you first begin your report.
There are certain reporting tasks that you can perform most efficiently by
creating multiple sections within an area, such as:

* Putting conditional messages in form letters

* Formatting objects/sections differently based on field values

Alternating background colors on a row-by-row basis

* Eliminating blank lines when fields are empty

Adding blank lines under specific conditions

When you understand the power of multiple sections, you discover many
ways that you can use them to produce the report effects you want. The
following are some ideas for using multiple sections:

Suppose you want to display current order amounts in the Details section. If
the customer has outstanding amounts you want to display them as well.
You add an additional Details section b, and conditionally format to display
only if there are outstanding order amounts.
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You are printing an employee listing grouped by Employee Name. You
have information on each employee, including address, telephone, start
date, and sales for the last month. You also have a field that displays the
employee's picture that you want to display beside the printed data. You
cannot put it in the Employee Name group header because it prints above
the rest of the data and takes up too much space. So you create a second
group header section, put the picture there, and then underlay the second
section under the Details for each employee.

You need a single page summary report of the top twenty customers.
Included in the report, you need a graph that shows each region's percent
of total sales. There is not enough room to print the graph above or below
the customer listing. You can put the graph in a Report Header b section
and underlay it under the Details section to print the graph beside the data.

Your report prints customer invoices and a list of the orders in the last
month. You want to include a nice letter to thank paid up customers for
keeping their account current. For overdue customers, you want a more
forceful letter asking them for payment. You can create two Group Header
sections and conditionally suppress each one depending on the condition
of the account. The Detail section would show all orders that have not been
paid along with their due dates.

These are only some ideas for using multiple sections. You are going to try
some of these ideas in following exercises.

Using the Section Expert to Work with Sections

In the Section Expert, you can easily insert, merge and delete sections.
You can also move sections within an area and conditionally format
sections. Remember, you can open the Section Expert in three ways:

* Choose Report|Section Expert...

* Click the Section Expert button E on the Expert Tools toolbar

* RIGHT click the section name you want to format, then choose Section
Expert from the shortcut menu
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In the Section Expert, you can select the area with which you want to work
in the Sections: list, and then click the Insert, Delete, or Merge buttons to
manipulate additional sections in that area. The arrow buttons allow you to
move sections within an area.

Section Expert @

Sectons; |zt Cammon | Colar

Fiepaort Header

Fage Header

Group Header #1: Supplier. Supplier Mame - &

Group Header #2; Product_Type. Product Type Mame - &
Group Header #3: Orderz. Order Date - A

Dretails

Group Footer #3: Orders. Order D ate - A

Group Footer #2: Product Type. Product Type Mame - A

Free-Faorm Placement
[ THide (Drill-Dovan 0K
[Jsuppress (Mo Dril-Down)

[JPrint at Bottam of Page

Group Footer #1: Supplier. Supplier Mame - &
Page Footer [IMew Page Before
Feport Footer ] Now Page after

[Jreset Page Mumber AFter
Keep Together

[J5uppress Blank Section

B (0 02 |0 |0 02 |6 |5

[Junderlay Following Sections

[Jread-onky
[Jrelative Positions

[ oK ][ Cancel H Help ]

You can also perform all these section procedures from the Section
shortcut menu. RIGHT click on the left side of the screen where you see
the section name of the section you wish to change. The shortcut menu
contains commands for inserting, merging, deleting and moving sections.
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Dietails

Hide (Drill-Diown QK
Suppress (Mo Dril-Down)

Seckion Expert...
Show Short Section Mames

Insert Line
Delete Last Line
Arrange Lines

Fit Section
Insert Section Below

Select all Section Objects

WARNING: If there is currently only one section in an
area, the Merge, Move and Delete commands do not
display. You only see the Merge command if you RIGHT
click on a section that has another section of the same
type below it.

Crystal Reports has a true shortcut for inserting a section below an existing
section. Left click on the vertical separator bar in the section you wish to
add. Hold down the mouse button until the mouse pointer changes to a
double-headed arrow with a single line horizontally separating the arrows.
Drag the line up or down and release. This method of inserting a new
section keeps all the formatting from the section above.

Dezign |

Fiepart Header | T

Fage Header N S

Detailz a I TR

Detailz b N TR

Repart Footer I TR

Fage Footer N TR

A



Crystal Reports XI Designer 2 Workshop ©2005 Vision Harvest, Inc.

Lesson 2: Power Formatting with Multiple Sections

s Exercise 2.0 — Insert an Additional Report Header Section

1.

10.

11.

12.

Create a report of Last Year’s Sales by Country using the Top
Customer view in the Xtreme Sample Database 11 data source.
Save and name the report Exercise2_0.rpt.

Group by Country.

Insert the Customer Name and Last Year's Sales fields into the
Detail section. Shorten the fields and move them to the left side of
the report.

Summarize the Last Year’s Sales field. Move the Group #1 Name
field from the Group Header into the Group Footer.

Change the column title for the Customer Name to Country.
Hide the Group Header #1 section and the Details section.

Place a text object into the Report Header section with the title Last
Year’s Sales by Country. Format the title like the illustration.

Create a bar chart to display in the Report Header. Open the Chart
Expert. On the Data tab, graph the groups on change of Country.
Set the value to Sum of Last Year’s Sales. This is the default.

In the Options tab, set the Bar Size to average and turn off the
Legend. In the Text tab, remove any text titles by turning off the
Auto-Text and delete all the text in the labels.

On the Color Highlighting tab create a condition so that bars are all
one color unless USA then the bar is red. When finished, click OK.

After Crystal Reports places the graph in the report, move it to the
right.

Save the report as Exercise2_0.rpt and preview the report.
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The report should be similar to the following illustration:

E¥ CrystalReports - [Exercise?_0.rpt]

Ig File  Edit “iew Insett  Farmab  Database  Report  Window  Help
DEe-H &S EB& (i=) - ER=RN e N R
Start PagP:/VEHercisez_l].rpt X] 4P
Design  Preview X | 73 1of1
1 1 1 2 1 32 1 I3 | O} 1 ] 1 T 1 a2
-
RH .
Last Year's Sales
By Countr
- y y 1300K
: 1000k
- B00K
_ GO0k
- dogkf——
o mok b
il4
- SOESGel Sl e A AbA RS AE Subd sl g
] e A M R
s ﬁ&@% e e ieter e S e
: o e P R ‘\{: % :ﬁ%& E th&g
(]
PH .
. Country Last Year's Sales
GF1 - Argentina $55,664.35
GF1 ) Austria $201,000.00
GF1 B B elgium $200,000.00
GF1 + Brazil $133.551.30
GF1 . CostaRica $56,343.90 w
< % ¥
For Help, press F1 10:4¢ 32,00:50x3.0 Records: 46 100%:

The report would look better if the graph displayed beside the records. You can
underlay the Report Header to accomplish this. However, if you underlay the
entire Report Header, then the title also displays under the customer
information. We need to place the chart in a separate section below the title
and then underlay Report Header b.

13. Return to Design view.

14. Insert a section below Report Header by right clicking in report header and
choosing Insert Section Below. Move the chart to Report Header b. Right
click in Report Header a and choose Fit Section.

13. RIGHT click the section name for Report Header b, then choose Section

Expert.
Notice the Section Expert now displays both Report Header sections.
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% Exercise 2.1 — Underlay a Section

1. Click the Underlay Following Sections check box, then click OK.

2. The use of a second Report Header section also lets you center the report
title without the under laid text printing on top of it. Move the title text object
to the center of the Report Header a. Resize the title as shown in the
sample.

3. Save as Exercise2_1.rpt and preview the report.

The report should look like the following illustration:

E¥ Crystal Reports - [Exercise2_0.rpt]

Igl File  Edit  Wiew Insert Formak Database  Report  ‘Window  Help
e -B & EB& i=) ) v ?=@@%ﬂ@ﬁlﬂﬂ%vk‘?|
Stark PagP:/VExerl:isez_I].rpt Xl q b
Design  Preview X | 7S tofl
L R L T R S - B R B BT BRI - SRR ISR - BB S S
M~
RHa
Last Year's Sales By Country
FH -
) Zountry Last¥ear'sSales
GF1 - Argentina $55,664.35
GF1 - Austria $201,000.00 1200k
GF1 i B elgium $200,000.00
GF1 - Brazil $133,551.30 1000k
GF1 ™ CostaRica $56,343.90 _—
GF1 . D enmark $97,459.70
GF1 . Dominican Republic $63,365.40 0K
GF1 - England $500,000.00
GF1 France $539,163.14 Kb
GF1 . Germany $559,468.94
GF1 o Hungary $59,255.70 r1]1] 3 A S
GF1 i Ireland $177,906.45
GF1 . laly $583,444.66 oK A M S AR AT
GF1 - | Mexico $146,202.45 OIS R L R A A
GF1 - | Netherlands $100,000.00 AT Gﬁ%ﬁﬁgﬁﬁ%&“ ;&@N""“::;:@ 6@1@‘3\3{@“@
GF1 . New Zealand $65,231.70 * ¥ & 3
< >
For Help, press F1 10:44 Records: 46 100%%
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Conditionally Formatting Multiple Sections

Now that you have a nice looking sales summary report, suppose you want
to include a congratulations message to those countries’ sales reps that
collectively sold more than $500,000. You want to display the message
directly under the name and sales figure for the county.

The country name and sales figure are located in the Group Footer
section. If you place the text message in the same Group Footer section
underneath the field objects, it will create additional spacing for each group
when the text message is suppressed.

To solve this problem, you can add another Group Footer section, add a
text object with the message in Group Footer #1b, and then conditionally
format to suppress this section if the Sum of Last Year's Sales field is less
t h a n 5 0 0 0 0 O

% Exercise 2.2 — Conditionally Format Multiple Sections

1. Return to Design view.

2. RIGHT click the Group Footer #1 section name, then choose
Insert Section Below.

3. Add a text object to the Group Footer #1 b section.

4, Type Congratulations to the sales representatives for. Select
from the Field Explorer, the Group #1 Name Country field and
place it into the text object. Continue to type You have each won
an all expense paid trip to St. Thomas!

Note we have inserted a group name field so that the text reads with
the correct country inserted.

5. RIGHT click the Group Footer #1 b section name, then choose
Section Expert.

X2
6. Click the "”l button after the Suppress (No Drill Down) check box.
7. Enter the following formula:

Sum ({Top_Customers.Last Year's Sales},
{Top_Customers.Country}) < 500000

8. Select the Save and Close button in the Format Formula Editor.
Close the Section Expert. Save and preview the report.
The message should only appear for those countries that have a
Sum of Last Year's Sales equal to or over $500,000.
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9. Save the report as Exercise2 2.rpt and close the report. Your
report should look like the sample.

EW. Crystal Reports - [Exercise?_0.rpt]

E‘l File Edit ‘“iew Insert Formgt Database Report  window  Help
DEe-H & E& ) - =B = A A 100% - (82
Start Page’/vEHercisez_l].rpt x] 4k
Design  Preview X | T, 1of1
1 1 1 2 1 a 1 4 1 5 1 =] 1 T
.Y
FHa
Last Year's Sales By Country
PH -
. Country Lazt Year's Sales
GFla - Argentina $55,664.35
GF1a - Austria $201,000.00 1200k
GFla B elgium $200,000.00
GFla - Brazil $133.551.30 1000k
GFla ™ CostaRica $56,343.90 a0k
GFla D enmark $97.459.70
GFla . D ominican Republic $63,365.40 B0k
GFla - England $500,000.00
GFlb ~ Congratulations to the Sales Rep for: 400k i1
B England. You have each won an all
o expenses paid trip to 5t Thomas, ook _ -
GFla - France $539,163.14 ok
GFlb Congratulations to the Sales Rep for: b Ealih b bl @ Do 1 g o B e b B D @ e
France. ¥ou have each wan an all hﬁ*;u‘&bf;g@m;ﬁQ% g%%‘i\%f%@ e!‘_:‘%’%%ﬁﬁj&k"
expenses paid trip to 5t Thamas. w EPY S %
< >
For Help, press F1 10:44 3.2,0.9:50x 3.0 Records: 46 100%:
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Challenge Exercise — Formatting with Multiple Sections

Suppose you need to create a Quarterly Sales report that shows the sales
for last year (2004). This will be a summary report including a graph of the
sales for each quarter and the sales totals for each employee. The finished
report needs to look like the following illustration:

E§ Crystal Reports - [Challenge? 1.rpt]

@ Eile Edit \Wiew Insert Format  Database Report  Wwindow  Help

Dee-H&E Ba& B - Ta D AR M 100% x| N2
StartPags/ Challenge2_t.rpt X | b
Diesigr Presview x| 73 1oft
e -1 2004 Sales Report
printed on 03/13/2005 Fdtremne

Mountain Bikes

CQuarterly Sales
Total Sales

GF1 . January 2004 $632,599.84
GH1 «
GF1 B April 2004 $866,033.31

GH1 . 043 638
July 2004 $714,813.61

October 2004 $653,638.42

14514

+ 966,093

< >

For Help, press F1 11:04 56,13 1.0=03 Records: 1563 100%

1. Start by creating a new report based on the Xtreme Sample Database
11. Add the Employee and Orders tables.

2. Use the Group Expert to insert a group on the Order Date field.
Choose to print the group once for each quarter. Insert another group
on the Last Name field.

3. Select only records in 2004 using the between operator.

4. Put the Order Date field and the Order Amount field into the Details
section at the RIGHT side of the report. Put the field headings into
Group Header 2.

5. Summarize the Order Amount field by Order Date (Group #1) and by
Employee Last Name (Group #2).
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6.

10.

11.

12.

13.

14.

Move the Group #1 Name field into the Group Footer #1 and position
it close to the summary field. You may need to resize it. Do the same
for the Group #2 Name field. Reformat the Group #1 Name field to
look like the following: January 2004.

Add the title and the print date to the Report Header section. Format
them like the example. Add the Xtreme logo. Add a subtitle “Quarterly
Sales” as shown in the example.

HINT: Use two text boxes and draw a line between the two text boxes.
If you want to resize the image you may need to disconnect it from the
repository before resizing.

Suppress the Page Header and hide the Group Header #2 section, the
Group Footer #2 section and Details section.

Now you are ready for the extra sections. The report needs to have a
graph of the sales by quarter displayed beside the summary values by
using the underlay feature. Since the graph appears once on the report,
you need to put it in the Report Header. To accomplish this we need an
additional Report Header section.

Insert a chart. Use the Chart Expert to ensure that it is a pie chart
graphing Sum of Order Amount by Order Date On the Options tab,
display the values and format them to look like currency with no
decimals ($1). Turn off the Legend. Turn off all the Auto-Text entries on
the Text tab and delete any text. If the Sum of Order Amount is greater
than 800000 then color the piece of pie red.

Insert a section below the report header. Move the chart to the left of
the Report Header b section and resize to be only 4” wide.

Turn on the Underlay following sections command for Report Header b
but not for Report Header a.

Finally you want to add a title for the quarterly sales figures. Add a text
object to Report Header a that lines up with the Order Amount
summary field. Type Total Sales. Format the box to be bold with a
bottom single border.

HINT: Since the Order Amount summary field is a number and aligns on
the right; select both the text object and the summary field, right click on
the summary field and choose Align>Rights. Right align the text in the
text object.

Save this report and name it Quarterly Sales. Preview the report.
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E¥ Crystal Reports - [Challenga2_1.rpt]

@ File Edit ‘iew Insert Faormat Database Repork  Window  Help

DE-EB& Bal B o-  =EEe U A K
StartPaga//l:hallengez_l.rpt Xl 4k
Design | Preview X | 73 1aoft
| I B - B R T S S - B B - SRR SR
] A
Ria 1| 2004 Sales Report

“| printed on 03/13/2005 Eﬂtreme

Mountain Bikes

Quarterly Sales

Total Sales

GH1 .
GF1 - January 2004 $632,599.84
GH1 o
GF1 ) April 2004 $866,033.31
GH1 553 638 532,600
GF1 - July 2004 $714.813.61
GH1 .
GF1 October 2004 $653,638.42
o
- 14,514
+ $366.033
. v
< >
For Help, press F1 11:04 56,1.3:1.0x03 Recards: 1563 100%
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Challenge Exercise — Conditionally Formatting Using DrillDownGroupLevel

The Quarterly Sales report displays summary level information. However,
when you created this report, you included the detailed information. The
information in the Group #2 sections and the Details section was hidden in
the previous exercise. If you drill down into the report by selecting the
summary information for January 2004, you will notice that the report will
display column headings for the first drill down. The drill down will look like
the following example:

E¥ Crystal Reports - [Challenge2_1.rpt]
|20 Fle Edt ¥ew Insert Format Database  Report  Window  Help
iDE-Jd & & i G FE D@ R 8 00 | w2
Start Page ]’Repurtq/’challengezg.rpt x] 4
Design | Preview | January 200+ X | H 1of 1
------- - T T T S R B SRR
~
GH1 B
GH2 - Order Date Qrder Amount
GF2 B Davolio  $87.741.84
GH2 n Qrder Date Order Amount
GF2 . Dodsworth  $132,435.81
GH2 - Grder Date Order Amount
GF2 - King $116,156.38
GHZ . Order Date Order Arnount
GF2 - Leverling $101,513.66
GH2 - Order Date Order Amount
GF2Z . Peacock  $77.645.46
GH2 . Order Date Order Amount
GF2 - Suyama  $117,106,69
GF1 - January 2004 $632,599.84
- ~
< 3
For Help, press F1 11:04 Records: 304 1

Obviously we do not want the column headings to appear at this level of
detail. However, we do not want to delete them, because they will serve a
useful purpose when you drill down to the order details for each employee.
In order to prevent the column headings from appearing at the first drill
down, we use a formatting option called DrillDownGroupLevel. By using
this function in conjunction with conditional suppression of a section, the
column headings will display at the order detail level, but not at the
employee summary level.

E¥ Crystal Reports - [Challenge2_1.rpt]
I% Eile  Edit View Insert Format Database Report  Wwindow  Help
DeE-Jd & & i) Tl T B 2 @ R 8 00 | w2
StartPage [ Reportd ” Challengez_Lipt X | b
Design  Preview  January 2004 Davolio X | 3 1of 1
- - B SR S N B BT - SO BT SR
~
GH2 - Order Date Order Amount
al - 02-January-2004 $2,897.25
o - 03-January-2004 $23480
8] T 04-January-2004 $43.50
o 06-January-2004 $27.00
al . 06-January-2004 $62 33
o - 08-January-2004 $27.00
o] - 09-January-2004 $1,709.72
o R 10-January-2004 $5,219.59
D - 10-January-2004 $9.00
o - 12-January-2004 $3,712.60
o] - 12-January-2004 $67.80
o N 13-January-2004 $655.70
o A 18-January-2004 $67.80
D 15-January-2004 $B7.80
o] - 19-January-2004 $35.70
n - 18-January-2004 §481.55 hd
< 3
Far Help, press F1 11:04 44,025 1,1x01 Records: 52 1
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In this exercise, you will format the report to only display the column
headings at the order detail level.

1. Return to the Design view. Right click on the Group Header #2
section and select the Section Expert.
X2 _ .
2. Locate the ==I button beside the Suppress option.
3. The DrillDownGroupLevel function is found in the Print State

functions list. The formula for preventing the group level drill down
for Group Header #2 is as follows:

DrillDownGroupLevel =1

4. Save and close the Format Formula Editor.
5. Save and Preview the report.
6. On the Preview tab, double click the value for January 2004.

Notice the information for January 2004 now displays the
employees and their summary information. The column headings
no longer appear at this level of detail.

7. Drill down to view the detail orders for Davolio. Notice the column
headings appear above the order date and order amount columns.

8. Save the report as Challenge2_2.rpt and close.

If you are unsure what the DrillDownGroupLevel value is for the
group you are working with, create a formula with the
DrillDownGroupLevel value in it and place it into the header.
You will then see the value as you drill down. Once you know
the value, simply place it into the Format Formula Editor as
shown above to prevent the heading from displaying on drill
down.
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Challenge Exercise — Conditionally Formatting Multiple Sections

Suppose you also want to include a message in the report that
congratulates all the sales reps with sales over $120,000 for each quarter.
The message only displays when the sales person drills down on the
quarter to see employee sales for that quarter. You only want the message
to appear under the employee names meeting the top sales goals for that
quarter. The results should look like this:

Davelic  $87.741.84
Dodsworth  $132,435.81
Congratulations, Anne!
You are one of the top sales producers
for this quarter.

King $116,156.38
Leverling $101,513.66
Peacock  $77,645.46
Suyama $117,106.69
January 2004 $632,599.84

Since the sales per employee is a summary field, there is no way to
compare it with summaries from other groups. So you need to add the
message, then suppress it based on a combination of which quarter it is
and the employee name.

1. Open the Challenge2_2.rpt report and return to Design view.

2. RIGHT click the Group Footer #2 section name at the left of the
screen, then choose Insert Section Below.

3. Add a text box to the Group Footer #2b section. Type
Congratulations, then insert the {Employee.First Name} field. Then
type ! You are one of the top sales producers for this quarter.

4. Resize the text object so it looks good to you.

5. Now you are ready to conditionally suppress the Group Footer #2b

section. RIGHT click the Group Footer #2b section name, then
choose Section Expert.

X2
6. Click the ml button after the Suppress (No Drill Down) check box.
7. Enter the following formula:

Sum ({Orders.Order Amount}, {Employee.Last Name}) < 120000
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8. Save and close the formula. Close the Section Expert. Save and
preview the report. Double click on the January 2004 sales to see if the
formula worked.

9. Save the report as Challenge2_3.rpt and close the report.
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The drill-down pages of the report should look similar to the following illustration:

BW. Crystal Reports - [ChallengeZ_3.rpt]

IEEFI File  Edit  Wiew Insert  Format Database  Report Window  Help

: | | | | |
DE-W & & | e =B E = AT M 00w - (8

Skart Page rRepnrt‘l/VEhallengez_S.rpt x] 4k

Design | Prewiew  January 2004 X | : 1of 1
[ T T T T T R - e e - B R
. ~

GH1 .

GFZa - Davolio $87.741.84

GF2a - Dodsworth  $132,435.81

GF2b N Congratulations, Anne!

You are one of the top sales producers
forthis quarter.

GFZa . King $116,156.38
GF2a - Leverling $101,513.66
GF2a ~ Peacock  $77.645.46
GF2a . Suyama $117,106.69
GF1 - January 2004 $632,590.84
(v}
o
< b3
For Help, press F1 11:29 Records: 304 100%;:

49



Crystal Reports XI Designer 2 Workshop ©2005 Vision Harvest, Inc.

Lesson 2: Power Formatting with Multiple Sections

Notes Page

AN





